Introducing Insight iCONTROL
Insight iCONTROL enables you to use the computer to control electrical devices such as motors and lamps. It can
switch them on and off in timed sequences or according to signals created by sensors. You define the control actions
by building control systems which contain a program of instructions. Insight iCONTROL offers a simple method of
designing control systems and introduces the sort of thinking involved in designing computer programs. The process
of solving control problems usually begins by breaking it down into simple stages. This is the essence of the Insight
method; each stage is represented by an easily understood everyday English instruction using the unique Insight
Problem-Solving Language. The result is a well-structured program script, ideal for practising the logical thinking
involved in computer programming.
In order to connect the devices and sensors to the computer, you need a control interface; this is a box of electronics
which plugs into the computer and provides sockets for connecting the devices and sensors. If you do not have a
control interface you can still perform control actions with animated graphics on the screen. Like design engineers,
you can build and test complete control systems on the computer alone, without any extra equipment. However, the
full potential of Insight iCONTROL is realised when you use it to control electrical models.
The software activities are based on eighteen everyday themes, chosen to attract the interest of young people. For
each theme there are resources containing components and instructions for building control systems.
Insight iCONTROL has four modes of operation:

Design mode for building or editing the control system which organises the instructions for action.

Run mode for showing how the control system works on the screen as a simulation.
Check mode for checking that the devices and sensors are connected to the interface correctly.

Control mode for sending the control instructions to the interface and controlling the model.

Insight iCONTROL has three alternative viewing windows to help you develop and test control systems:

Scene view shows an animated picture of the simulation.

System view shows a diagram of all the active components and how they are linked.

Connections view shows how to connect the model to the interface

About Insight iCONTROL
Insight iCONTROL is designed by Dr Laurence Rogers, University of Leicester, programmed by Martin Williams and
published by Insight Resources. It is a companion to Insight iCON software for the PC for developing programming
skills using the Insight Problem Solving Language.
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Resources
The Home screen offers a range of resources which will help you get started, practise programming control
systems in a variety of scenarios, or do your own thing. Select a tab from the following:

New
This is for users who want to experiment with their own ideas. You can choose or import your own background and
have access to the full range of sensors and devices stored in Insight iCONTROL.

Tutorials
This is for first-time users. The Quick-start exercises contain instructions to help you understand how to program basic
control systems. Each exercise contains an example control system and a useful follow-up activity is to build and
program a copy of the system. This may then be followed by tackling selected Fix-it exercises (see below).
For each type of control module there are also ready-built control systems which illustrate and explain how they are
used.

Fix-its
This gives a range of simple exercises ideal for learning how to use Insight iCONTROL. Each example offers a
control system which is defective in some way, and the task is to alter and re-program it to make it work better.

Projects
This tab gives access to a range of scenarios to help you build and program control systems with the minimum of
fuss. There are two versions of each scenario: one contains prepared sensors and devices but requires modules to
be defined and programmed; the second version contains completed control systems and instructions for extending
them and developing further systems. Every project contains a store of sensors and devices for the Scene view.

Examples
This offers complete ready-built systems for all the project scenarios, illustrating the full potential of Insight iCONTROL.

My Work
This tab stores all the systems you create or adapt for yourself.
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Insight Problem Solving Language (IPSL)
A good method of devising a solution to a control problem is to break it down into simple stages and attempt to
describe each stage in plain English. These descriptions are likely to be expressed in a variety of different styles, all of
which may be perfectly valid. There is however a preferred style which makes it easy to convert the descriptions into
coded instructions within a computer. This is the basis of IPSL sentences which are designed to have a common and
logical structure which is readily understood and executed by the program. As you get to know Insight iCONTROL,
you learn to express your solution in IPSL sentences so that there is a close match between your own sentences and
the instructions generated by the program.
Here is a typical IPSL instruction:
"When the button is pressed, ring the bell until the button is released."
This is structured in three parts: "When the button is pressed, ring the bell until the button is released."
In general the three parts describe the following actions:
1. When something happens or a condition is fulfilled... (the WHEN setting)
2. ...do something... (the action)
3. ...until something else happens or a second condition is fulfilled. (the UNTIL setting)
Examples of part 1:
"When the switch is closed..."
"When it gets hot..."
"When the lamp is off..."
"After 2 seconds..."
If not required, Part 1 can be omitted altogether, in which case the 'do something' action is performed straight away,
unconditionally.
Examples of part 2:
"...switch on the buzzer..."
"...measure the time..."
"...count how many times the button is pressed..."
Examples of part 3:
"...until the switch is open."
"...until the lamp is off."
"...for 5 seconds."
If appropriate, Part 3 can also be omitted, in which case the 'do something' action continues until you exit Run mode.
IPSL instructions are built in Design mode by choosing the appropriate WHEN setting for Part 1, the instruction type
and the device to be controlled for Part 2, and the UNTIL setting for Part 3. As the settings are adjusted, so the IPSL
instruction becomes automatically updated. The settings are the critical features which determine the functionality of
the control system. The consequent IPSL instruction expresses these settings in a readily understood form. As users
develop their programming skill, they learn the significance of these settings and associate them with the instructions.
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Control Systems with Insight iCONTROL
In a control system a sensor sends a signal to a control module which contains a program for
controlling an output device. Insight iCONTROL enables you to create systems and write
programs which make them work.
The heart of a control system is the control module which has an input (for receiving signals
from sensors) and outputs (for sending signals to devices). The control module contains a
program for making decisions and giving instructions.

System view

Insight iCONTROL offers another view of the same system using pictures instead of boxes and
symbols:

Scene view

In Run mode the control module is invisible but its program shows as an instruction in the
text panel:

"When the button gets pressed, switch on the fan (forwards) until the button gets
released."
The links show that the module controls the fan according to signals from the push button.

Touching the push button makes the fan move according to the the control instruction.
Selecting Design mode makes the control module visible.
Touching the module makes the tabs to appear. These
enable you to program the module. As you touch each tab,
you can define a different part of the control instruction.
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This programs the first part of the control instruction: "When the button gets
pressed, ..." Clicking the push button shows the other options.

This programs the middle part of the control instruction: "... switch on the fan
(forwards) ..." Clicking the fan shows the speed and direction options.

This programs the end of the control instruction: "... until the button gets released."
Clicking the push button shows the other options.

Time is an alternative to the input signal from the push button: Instead of waiting for the
button to be pressed or released, the module can wait for a certain time to elapse.
For example, if you want the fan to switch off after 2 seconds, you can change the control instruction to read "When the button gets pressed, switch on the fan (forwards) for 2 seconds"
by dragging a line from UNTIL to TIME and then selecting the time using the yellow adjuster box:

To see how the new instruction works, you must select Run mode.
In the System view, you will see that the control system diagram works in the same way as
in the Scene view.
Return to the Scene view.
When you have built a successful control
system, you can switch to Run mode to control
real models connected to the computer. Models
contain switches and sensors for detecting
signals and activated devices such as lights,
motors, and buzzers etc. These are connected
to the computer via a hardware interface.
The Home screen offers a wide selection of colourful project scenarios.
The above example is the Basic control that can be found in the Tutorials section.
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Scene view
This view shows your control system as a working picture. You can select a background picture and all the
sensors and devices are shown as animated images. In Design mode, modules are shown as objects
together with all the information links as in the System view, except that the layout is more naturalistic. If the
layout makes the system look complicated, you can easily switch to the System view for editing purposes.

In Run mode, the modules and links disappear, giving the picture a natural appearance.

Click 'Reveal' to show where sensors and switches are located.

In Design mode, sensors and devices are selected from the popovers which show when you click on
the component buttons.

In some scenes, the object button
offers additional images with no function except to add visual interest.
All images may be moved and scaled to any size.
Captions may be added to the scene as labels or information.

Click 'Fit' to make the scene fill the window.

Click to delete the highlighted item/s.

Click the Edit menu for a range of adjustments to the images in the Scene. The 'Set background' option lets
you choose another background picture or import your own photo as a backdrop.
Click to show 'Quick Help'. Click again to show 'Help Topics'. (For the Tutorials, a click on this button will
also restore the notes panel.)

Designing and editing in the Scene view
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System view
This shows your control system as a series of boxes representing sensors, devices, modules and viewers.
The links between boxes show the flow of information.

In Run mode, all the sensors are active. Just click on them to change their state.

In Design mode, sensors, devices and modules are selected from the popovers which show when you
click on on the component buttons.

Click on an item to place it in the System view. All images may be moved and scaled to any size. The name labels of
the boxes can be changed by clicking them twice - an editing popover appears.
You create links when you program a module. An arrow on a link from a sensor indicates that module will use a signal from that sensor. Similarly, an arrow on a link to a device indicates that the module will control that device by
sending it a signal.
Captions may be added to the system diagram to help explain how it works or give it a title.

Click 'Fit' to make the systems fill the window.

Click to delete the highlighted item/s.

Select ‘Edit’ menu for a range of adjustments to the components in the System.
Click to show 'Quick Help'. Click again to show 'Help Topics'. (For the Tutorials, a click on this button will
also restore the notes panel.)

Designing in the System view
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Sensors
Sensors are normally linked as inputs to a control module. You can select the type of sensor you want in Design
mode from the toolbar. There are two main types:

Digital sensors are switches which give signals as an ON state or OFF state.

Examples in the Scene view: Push button, simple switch, wall switch, mains switch, cord switch, microswitch, pressure mat, magnetic switch, optical switch, light gate. Sometimes the image shows an object in which the switch is hidden. For example, a door or window might have a magnetic reed switch or microswitch attached to them which are
activated when they are opened or closed. Sometimes the image contains a red flash symbol to make it clear when
the switch is in the ON position.
In Run mode, just click the sensor object or picture to make its signal change .
In Design mode, double click the sensor to edit its name.
Analogue sensors give signals which can have any value from zero up to a maximum:

Examples in the Scene view: Light level sensor, thermometer, thermostat, sound level sensor, microphone.
In Run mode, click on the sensor object or picture to show its level adjuster buttons in the top panel.
In Design mode, double click on the sensor to show the name
editing box and the buttons for adjusting the start value and the
signal threshold which defines a digital switching action: When the
signal goes above the threshold, the sensor shows an ON state;
below is OFF. The threshold property is useful when choosing a
signal condition in a module program.

In Design mode the number of sensors appearing on the toolbar drop-down lists depends upon the Design level
selected on the 'View' menu:
● Junior level limits the number of sensors appearing to those shown in Insight iCON;
● Intermediate level increases the selection
● Advanced level selects all the available components.
You can customise your own selection of sensors from the 'Edit' menu: Choose 'Preferences' and click on 'Components...'.

In the Scene view, the Sensors button opens a Gallery window showing a variety of items appropriate to the
current scenario. To choose and item, drag it from the gallery window into the main view.

Sensors gallery (example)
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Devices
Devices are output components controlled by a module. You can select the type of device you want in Design mode
from the toolbar. There are two main types:
Digital devices which have either an ON state or OFF state: Lamp, buzzer, bell, relay, solenoid.

Analogue devices which can have more than one ON state: Motor, lamp. In the case of the motor you can set its
speed and direction.

In Run mode, a device object shows an ON state when it receives an ON signal.
In Design mode, double click the device to edit its name.

In Design mode the number of devices appearing on the toolbar drop-down list depends upon the Design level
selected on the 'View' menu:
● Junior level limits the number of devices appearing to those in Insight iCON;
● Intermediate level increases the selection;
● Advanced level selects all the available components.
You can customise your own selection of devices from the 'Edit' menu: Choose 'Preferences' and click on 'Components...'.

In the Scene view, the Devices button opens a Gallery window showing a variety of items appropriate to the
current scenario. To choose and item, drag it from the gallery window into the main view.

Devices gallery (example)
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Insight Modules
Insight modules are used for defining the instructions executed by your control system. There are four types of module:
1. Control modules for switching devices on and off:

Simple control: Switches on a device immediately and keeps it switched on for a certain time or until a signal changes.
Signal control: Switches on a device when it receives a signal from a sensor. The device remains switched on for a
certain time or until a signal changes.
Pulse control: When it receives a signal from a sensor, it switches a device on and off alternately for a certain time
or until a signal changes.
2. Function modules for creating and showing values which can be sent to other modules:

Timer:
Counter:
Calculation:
Memory:

Measures the time interval between two events
Counts the number of events at a specified input.
Performs an arithmetic calculation on two values or numbers.
Records a single event at a specified input. It behaves like a 'latch' in electronic circuits.

3. Information modules for presenting text, sound or data on the screen:

Message:
Sound:
Logger:

Shows a text message on the screen
Plays sound or music through the computer's sound system
Records the signals from analogue and digital inputs and shows the results on a graph.

4. Command modules for pausing or repeating instructions, calling another module or resetting a value:

Pause:
Repeat:
Call:
Reset:

When it receives a signal, the instruction pauses for a certain time or until a signal changes.
The instructions that follow are repeated a certain number of times.
Executes the instructions in another module.
Resets a value to its initial 'null' or undefined state.

The control sentence (instruction) for a module appears in the text panel at the top of the window. The sentence is
built by choosing the 'When' and 'Until' settings. In Design mode, click on a module to show its settings tabs .More
Insight modules can be changed into a different type (in Design mode) by DOUBLE clicking on the module. Select a
different type from the popover menu.
Insight modules may be merged to make a sequence of instructions: Arrange them vertically in downward order, drag
a rectangle around to highlight them, DOUBLE click on one module and select 'Merge selected modules'. More
In Design mode the number of devices appearing on the toolbar drop-down list depends upon the Design level selected
on the 'View' menu: Junior level limits the number of devices appearing to those in Insight iCON;
Intermediate level increases the selection;
Advanced level selects all the available components.
You can customise your own selection of devices from the 'Edit' menu: Choose 'Preferences' and click on 'Components...'.
Programming an Insight module
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Designing in the Scene view - Choosing the items
Choose a project from the Home screen.
Set the program to Design mode

Click the output DEVICE button to show the range of items.

Drag a device to place it in the window.
● The range of devices usually includes a variety of electric lamps, buzzers, relays and motors. In the case of motors,
the motor is often hidden inside the object shown by the image.
● You can place the device picture where you like by dragging it. If you want to make it larger or smaller, simply drag
one of its corner handles and alter its size. Double Click on the device to change its name.

Next, click the INSIGHT MODULE button:

Click a module to place it in the window.
● Choose a 'Signal control' module for a basic controller which switches on a device when it receives a signal from a
sensor. It does not matter where you place the module in the scene; when you later come to run your picture, all
modules become hidden. The other types of module are described in Insight modules. Double Click on the module
to change its name.
Next, click on the input SENSOR button to show the range of sensors and switches.

Drag an input sensor to place it in the window.
A sensor is used to send a 'signal' to the control module. The range usually includes a variety of electric switches,
push buttons, temperature sensors and light sensors. Sometimes, the switch is hidden inside the object shown by the

Start programming the Insight module.
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Designing in the System view - Choosing the items

Set the program to Design mode.

Click the output DEVICE button to show the range of items.

Click on a device to place it in the window.

Then click the INSIGHT MODULE button:

Click on a module to place it in the window.

Then click the input SENSOR button to show the range of sensors and switches.

Click on a sensor to place it in the window.
● The minimum control system consists of one device linked to one Insight module. More complex systems can be built
by adding sensors and further control modules in series or parallel. For more details of the different types of modules
available, go to Insight modules.

● A summary of the status and interface connection sockets is available in the 'Inputs' and 'Outputs' options on the
'View' menu.

Start programming the Insight module.

© 2015 Insight Resources

12

Designing in the System view - Programming the Insight module
Highlight the module by clicking it.
Touch the OUTPUTS tab and drag a link
from the tab to the device you want to
control. You can link as many devices as
you want. (To remove a link, just click it.)

The Insight module works by taking the signal from the sensor and using it to decide when to switch the output device
on or off. The decisions are shown in the control instruction in the text panel at the top of the window.
In this example, the middle part of the instruction now shows: "... switch on the motor (forwards) ..."
To build further a control instruction you need to change the WHEN and UNTIL settings in the module:

Touch the WHEN tab and drag a link from the
tab to the sensor. You have to choose what the
sensor must do to switch on the device. For a
push button, the choices are:

(If you choose 'gets pressed' the device will switch on only at
the moment the button becomes pressed rather than simply
responding to the state of the button.)
In this example, the first part of the control instruction now shows "When the button gets pressed ..."

Now touch the UNTIL tab and drag a link
to the sensor that you want to switch the
device off. Choose the condition as
required.

The last part of the control instruction may now read "... until the button gets released."
The control system and the control instruction should now be complete.
"When the button gets pressed, switch on the motor (forwards) until the button gets released."

● Test the system:
Set the program to Run mode. Test how your system works by clicking the sensor boxes in the System view.

© 2015 Insight Resources

13

Programming with TIME
Highlight the module by clicking it.

Touch the UNTIL tab and drag a link to the
TIME tab. (Or click UNTIL then click TIME.)

Move the slider to choose a time for the action.

The second half of the control instruction may now read "... switch on the motor (forwards) for 2 seconds."
To cancel the TIME setting, click the TIME tab.
To edit the TIME setting, click the TIME tab twice.

Programming Two inputs
A link may be made to a second sensor or to TIME.
When you choose the condition/setting for the second sensor, you must also choose how their signals are combined:
Signal 1 AND Signal 2 or Signal 1 OR Signal 2

This examples gives an instruction which begins "When the switch is closed and the button is pressed..."
To alter the setting for either sensor, click on its drop down box and reselect the setting.
The UNTIL setting can can come from two sensors in the same way. Also, one of the signals may be from TIME.
To revert to one input, click 'Delete' or click the link to the unwanted sensor. To remove a TIME input, click 'Delete' or
click the green TIME tab.
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Creating a Sequence of instructions
If you want a module to perform a second instruction immediately after the first, DOUBLE click on the module, select
'Add instruction' and choose the type of instruction required. Edit the WHEN and UNTIL settings as you wish.

In this example, both instructions appear in the text panel:
"When the button gets pressed switch on the motor (forwards) until the button gets released.
After 2 seconds, switch on the motor (backwards) until the button gets pressed."
You can add further instructions in the same way. Each instruction in the sequence can be selected using the arrow
adjusters on the module and edited in the normal way.

As an alternative, you can create a second module below the first and program it with the new instruction. Then
highlight both modules (drag a rectangle around both), DOUBLE click on one of them and select 'Merge selected

It is possible to change the order of instructions in a sequence by separating the modules: Re-arrange their vertical
order, with the first at the top and last at the bottom, then merge them again. More
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Editing a control system
Set the program to Design mode.
Names: You can edit the names of sensors and devices: DOUBLE click the item you want to re-name. For a module,
DOUBLE click and select 'Edit module name' on the popover.

Size and position: Tap an item to highlight it. Several items may be highlighted by dragging a rectangle around
them. Once highlighted, an item may be moved by touching its centre and dragging it. An item may be resized by
dragging the corner and side handles of the item box.
Module settings: Tap a module to highlight it and show the settings tabs.
The WHEN tab controls the starting action, and the UNTIL tab controls the finishing action. Click them one at a time to
alter the settings. The tabs become shaded when active.

In this example, the WHEN setting is active; a click on 'push button' shows the starting options and you can select a
different option. The green link shows that the WHEN setting is using the push button. To break the link, just click it. A
new link can be made by dragging one from the WHEN tab.
Check that the control instruction in the text panel shows what you want.
If a WHEN or UNTIL setting uses time, the TIME tab is shaded green. To alter the amount of time, click on the TIME tab
twice and adjust the slider.
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For a motor device, you can alter its speed and direction: Tap on the OUTPUTS tab, then on 'motor' and adjust the
settings.

For a temperature sensor, you can set a start value and a 'threshold' value for specifying 'hot' and 'cold' in the control
sentence. DOUBLE click on 'temperature' to show the popover.

The same adjustments can be made for the light sensor to specify 'light' and 'dark' and the sound sensors to specify
'noisy' and 'quiet'.

Editing a sequence of instructions
When a module contains a sequence of instructions, this is indicated by the adjuster arrows in the module box. Tap
these to step through the sequence. The active instruction for editing is shown by the number.

If you want to change the order of the instructions,
DOUBLE click on the module and select 'Separate
module instructions'. This shows an array of
modules each with a single instruction. Change
the order by re-arranging them vertically in a
downward direction. To recombine them to make
the new sequence, drag a rectangle around all the
modules, DOUBLE click on one of them and select
'Merge selected modules'.
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Running a simulation and control system
Set the program to Run mode.
The sentences in the text panel show the current instruction (program) for each Insight module:

If you click the text panel, the program script shows all the instructions for all the control modules. Sometimes a
module is programmed with several instructions to be performed in a sequence (as with the Bed light control in this

The boundary with the picture may be dragged up and down.
In the System view, click the switches or input sensors to make the control systems do their work in controlling the
devices. In the case of a temperature, light or sound sensor, adjust the value in the popover at the top of the screen.

In the Scene view, click the Reveal button
to show where the switches and sensors are located in the
simulation. As you click the switches or sensors, the devices can be controlled.

At any stage, click the Fit button to make the images fill the viewing area.

As you make the control systems work, check out the program script in the text panel and identify the sentence which
describes the action you are controlling. If you want to change or modify the action, you will need to edit the program
for each module in Design mode. More
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Connecting and controlling a working model

When you have designed and tested your system on the screen and shown that it performs in the way that you want,
it is time to build the real working model and connect it to the computer. To do this you need an interface box with
input and output sockets. Most interfaces need to be connected to one of the USB sockets on the computer.
iCONTROL can work with a variety of different manufacturers' interfaces so you need to check that the correct
interface is selected. Do this in the Interface... dialogue on the 'File' menu.

Select the Connections view to find out how to connect the sensors, switches and electrical devices on your
model to the interface box.
Note that: sensors and switches are plugged into the input sockets; devices are plugged into the output sockets. Be
sure that you use the sockets exactly as shown in the Connections view.

Check that the interface is switched on and set the program to Control mode.

Click Start.
In Control mode your working model is controlled by the computer following the instructions for each control module.
Your model should now behave in the exactly the same way as when you tested the system on the screen. As the
model operates, the status of the outputs and inputs and the progress of the program are shown on the screen and
the top portion of the window shows the current instruction. Troubleshooting

You can interrupt the working of the model by clicking on the 'Pause' button on the toolbar. A second click on
this button makes the model resume working according to the current instruction.

To stop the model working completely, click on the 'Stop/Reset' button on the toolbar or, in emergencies,
press the SPACE bar on the keyboard.

When in Control mode, you can also select the System view or Scene view.

Controlling a model in Remote mode.
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Connections view for controlling a working model

This shows how to connect sensors, switches and electrical devices on your model to your interface box.

In Run mode, all the sensors are active on the screen. Just click on them to change their state.

Check mode helps you test the sensors and devices to ensure that they are connected and working properly, but first, the interface box must be connected to the computer, usually to the USB socket. Sensors and switches
should be plugged into the input sockets following the order on the box shown in the window. Similarly, devices
should be plugged into the output sockets as shown in this example.

When you press a button or close a switch, their boxes in the window should change to blue if the connections are
good; when you click on a device box in the window, the device connected to the interface should become activated
if the connection is good.
In Control mode, if the interface box, sensors and devices are connected,
your control system will make your model work.
Use the Stop, Pause and Play buttons to start or stop the control system.
The SPACE bar also pauses the control.

Click to show 'Quick Help'. Click again to show 'Help Topics'.

Trouble-shooting with check mode
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Trouble-shooting with Check Mode
Having connected model to the computer via the interface, if the model does not respond or does not seem to work in
Control mode try these checks:
● Ensure that the interface is switched on and correctly plugged into a USB or serial port on the computer.
● Ensure that the interface driver software has been installed correctly on your computer.
● Check that your type of interface is selected on the Interface dialogue box (File menu) and that you have
selected the correct USB or 'COM' serial port setting.
● Check that the sensors and devices are correctly connected to the output and input sockets. Use the
Connections view to check the allocation of sockets.

Set the program to Check mode by clicking on the Check button on the toolbar. The purpose of Check mode
is to help you check that individual sensors and devices are working properly and can be controlled by the computer.
Check the input sensors: When you press a button or close a switch, the sensor object on the screen should become
highlighted with yellow in a blue box.

If the highlight fails to appear, look out for:
● Broken or loose wires and plug connections to the sensor.
● Light sensors: some types have positive and negative plugs which must be connected the right way round.
● Microswitches: most types have three possible connections and you need to check which two are required.

For analogue sensors, (such as temperature, light and sound level) the signal reading is displayed in the sensor
object. If the signal level is above the predefined threshold, this is regarded as the 'high' state and the yellow highlight

Check the output devices: When you click on a device object on the screen, the actual device should become
activated e.g. a lamp should light up or a buzzer should sound. If a device fails to respond, look out for broken or
loose wires and for faulty plug connections to the device.
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Controlling a model in Remote mode
Some manufacturers' interfaces can work independently from the computer, that is, they can control models whilst
disconnected from the computer. This release of iCONTROL supports this type of 'remote' activity for the FlowGo interface from Data Harvest and the RCX Brick from LegoÒ . The process of designing suitable systems is exactly the
same as for normal interfaces, that is, you can design the whole system on the computer screen in Design mode and
Check mode can be used to check that the sensors and devices are all working correctly.
Make sure that the interface driver has been installed.

Control mode can be selected in the normal way to make the control system in the computer control the model.

Remote mode is selected on the 'File' menu.

Setting up Remote mode for the FlowGo interface
The FlowGO should be connected to one of the USB sockets on the computer.
It should also be connected to a 6 volt mains power supply.
When connected, the green GO LED should light up. If the GO
LED is flashing, press the GO button once so that the LED stays
● Select Remote... from the 'File' menu. The code will
automatically download the control program to the interface.
● Press the GO button to start the control program. A
flashing GO LED indicates that the program is running.
● If at any stage you want to stop the program running, press
the GO button.

The downloaded control program remains in the FlowGo interface, even after the power supply has been removed.
It remains until it is overwritten by another program.

Setting up Remote mode for the RCX Brick
Before the RCX Brick can be used in Check mode, Control mode or Remote mode
(selected on the 'File' menu), the computer must first send the system instructions to
the interface. Insight iCONTROL normally does this automatically when you first select
one of these modes. This may take a minute or two. You must ensure that the infrared
transmitter tower has line-of-sight communication with the infrared eye receiver on the
RCX Brick. For Check mode and Control mode, it is essential for this communication
to be maintained all the time. The best conditions for this are when the transmitter and
receiver are up to 20cm apart. For Remote mode, once the transfer is complete, the
interface does not need any further communication with the transmitter or instruction
from the computer; just press the 'Run' button on the RCX Brick.
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Interface driver software
Each type of interface requires a small 'USB driver' program to facilitate communication with the computer. These
programs are supplied by the interface manufacturer and are normally installed automatically when you install the
manufacturer's proprietary control software. This only needs to be done once for the computer in use with the
interface. Thereafter, Insight iCONTROL will be able to commmunicate with the interface.
If, for some reason, the USB driver becomes corrupted or deleted, it may be re-installed using the Windows operating
system. The usual procedure for this is:
● Disconnect the interface from the computer USB socket.
● Make sure that the interface has its power supply connected and is switched on.
● Re-connect the interface to the computer USB socket.
● Windows will automatically search for the necessary driver. If you have the interface installer CD at hand it is
advisable to insert it into the CD drive. Failing this, the Insight iCONTROL installer CD contains a folder with
several suitable USB drivers. If this also fails, you should download a suitable up-to-date driver for your
model of interface from the manufacturer's website.
● As soon as the appropriate driver has been located, Windows will install it automatically.
You can check the installation of the driver by going to Windows Control Panel and selecting 'View drivers and

Captions

Captions may be added, in Design mode, to the Scene view or System view to enhance the picture or
explain the system. The sets of captions in each view are independent of each other and you can adjust their shape
and size as you wish.
To create captions, click on the Caption button on the main toolbar and type the required text in the Caption editing
window. If the ‘Auto-size’ box is ticked, the caption text will automatically fill the caption box, whatever its shape or
size. If the ‘Centre’ box is ticked, the text will be centre justified horizontally.
If desired, you may link captions to sensors or devices using the 'Pointer' tab when highlighted.. Linking may be
useful, for example, for showing the flow of information in a system diagram.
To edit captions, select Design mode and double click on the required caption. Make the changes in the Caption
editing window.
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Simple Control

This module is used to switch on a device straight away. No input sensors are required.
The device will be switched off:
●
●
●
●

after a specified time interval
by an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example 1
In this example the output is linked to a single light by
dragging a link from OUTPUTS to the light.

If the UNTIL setting is not defined, the control
instruction becomes "Switch on the light until
exit." Thus the light remains on all the time until you
exit Run mode.

If the UNTIL setting is a time of 2 seconds (by
dragging a line from UNTIL to TIME and choosing 2
seconds), the control instruction becomes "Switch
on the light for 2 seconds. Repeat.

A single module instruction always gets repeated until you exit Run mode, so in this case the effect is the same as if
no time were specified. If you want the light to go off after 2 seconds, you must add a Pause instruction.
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Example 2
In this example three lights are linked to the outputs
of the module. There is a sequence of four timed
control instructions:

As with all module programs, the sequence is repeated as a loop until you exit Run mode.
These examples will be found in the Tutorials section of the Home screen.

Back to Insight Modules
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Signal Control

This module is used when you want to use a signal from a sensor or other source to switch on then switch off a
device. The device will be switched on or off:
●
●
●
●

after a specified time interval
by an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example 1

This example shows a push button controlling a motor. The WHEN setting is made by dragging a link from WHEN to
the push button. Then, clicking on the push button shows the choice of start conditions. The choice of 'gets pressed'
waits for the moment when the button is touched (in Run mode).
Similarly, the UNTIL setting is made by dragging a link from UNTIL to the push button. If 'gets pressed' is chosen for
the UNTIL setting, the motor will be switched off when the button is pressed a second time. The resulting instruction
is "When the button is pressed, swtich on the motor until the button gets pressed (again)."

Example 2

In this example, a temperature sensor controls a relay, simulating the behaviour of a thermostat. The WHEN setting
is made by dragging a link from WHEN to the temperature box. Then, clicking on the temperature box shows the
Simlarly the UNTIL setting is made by dragging a link from UNTIL to the temperature box and then choosing from the
'continue' conditions. If 'is warmer than 20' is chosen, the resulting instruction is "When it is cooler than 20, switch
on the relay until is is warmer than 20."
These examples and others may be found in the Tutorials section of the Home screen.
Back to Insight Modules
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Pulse Control

This module is used to switch a device on and off repeatedly. The device will be switched on or off:
●
●
●
●
●

after a specified time interval
by an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition
after a certain number of pulses

Example 1
In this example, pressing the button makes the light flash several times.

The UNTIL setting can be defined either by specifying the total time for the pulses, or by specifying the total number of
pulses.

To specify time, a link is dragged from UNTIL to TIME and the slider adjusted to show the chosen elapsed time.
Then touch PULSES tab and choose the ON time for each pulse (flash). The ratio between the On and OFF time may
also be adjusted. When the ratio is 1:1, the OFF time is the same as the ON time. The number of pulses is
calculated automatically.

The result of the above settings is to give the control instruction "When the button gets pressed, flash the light for
3 seconds"
© 2015 Insight Resources
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Example 2
In this example, the number of pulses is specified instead of the time.

This time, drag a link from UNTIL to PULSES. Then adjust the slider to give the number of pulses you want.

The result of the above settings is to give the control instruction "When the button gets pressed, flash the light 6 times"
If you change your mind and want to specify time, as in Example 1, click 'Do not specify the number of pulses'.
These examples will be found in the Tutorials section of the Home screen.

Back to Insight Modules
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Timer module

This module allows you to measure the time interval between two events indicated by changing signals.
The module can be programmed to begin and end the time measurement:
●
●
●
●
●

straight away (beginning only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example 1
This example shows how the Timer module can measure how long the push button is held down.

Tapping the Timing tab shows a popover which allows you to choose from three timing options:
● Increasing: Measure the elapsed time, counting up from a Start time.
● Decreasing: Measure the elapsed time, counting down from a Start time.
● Clock: Show clock time. This is not a measurement at all. It simply displays the time on the iPad's real time

The program stores and displays the measured time for this module in a viewer which is always linked to the module
in the Scene window or System window. (If no viewer appears to be available, click 'Reset viewer' to create a new
one.) The number of decimal places displayed copies the number of decimal digits for the Start time, in this case two.
The Visible and Hide settings allow you to choose whether the viewer is displayed or hidden in Run mode when not in
In this example, in order to read the time in the viewer, a second instruction (Pause) must be added. The resulting
program script for this module reads:
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Any module (including the current one) can use the time value in the viewer for a WHEN or UNTIL setting; just drag a
link from the WHEN or UNTIL tab to the viewer. As a reminder that the timer is providing a signal to another module,
the link is visible as a dotted line in the System window.
The Timer value can also produce a digital 'high' signal for use by other modules. To set this up, DOUBLE click the
viewer and set the 'threshold' to the time you want to be recognised as 'high'. In Run mode, when the time exceeds
the threshold, the value is recognised as a 'high' signal.

Example 2
This example shows how the timer module can be used to count down time from a starting value (in this case 10.0)
down to zero.

As in Example 1, the number of decimal places displayed in the viewer copies the number of decimal digits for the
Start time
Tapping a link from UNTIL to the Timer viewer allows you to choose the UNTIL setting, in this case "is less than
0.00". The resulting program instruction reads:"When the button gets pressed, measure the time until the timer
viewer is less than 0.0."
Example 3
This example shows how the Timer module can be used to display 24 hour clock time in a viewer.

The resulting instruction for this module reads: "Display a clock until exit."
These examples may be found in the Tutorials section of the Home screen.

Back to Insight Modules
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Counter module

This module allows you to count events indicated by changing signals.
The module can be programmed to begin and end counting:
●
●
●
●
●

straight away (beginning only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example 1
This example shows how the counter module is used to count changes in an input signal. In this case, the counter
shows how many times the push button is pressed..

Dragging a link from the Counting tab to the push button shows a popover which allows you to choose the events you
want to count, in this case "when the button gets pressed":

You can also choose from two counting options:

● Count up: Increasing from a value.
● Count down: Decreasing from a value.

The program stores and displays the counter value for this module in a viewer which is always linked to the module in
the Scene view or System view. (If no viewer appears to be available, click 'Reset viewer' to create a new one.) The
Visible and Hide settings allow you to choose whether the viewer is displayed or hidden in Run mode when not in use.
The resulting program script for this module reads:

Any module (including the current one) can use the counter value in the viewer for a WHEN or UNTIL setting; just
drag a link from the WHEN or UNTIL tab to the viewer.
The Counter value can also produce a digital 'high' signal for use by other modules. To set this up, DOUBLE click the
viewer (grey part) and set the 'threshold' to the time you want to be recognised as 'high'. In Run mode, when the time
exceeds the threshold, the value is recognised as a 'high' signal.
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Example 2
This example shows how the Counter module only counts the button pushes while the switch is closed.

Dragging a link from WHEN and UNTIL to the switch allows you to choose these settings. In this case the resulting
program instruction reads:

Example 3
This example shows how to count the number of times an output device switches on. In this case, the number of times
the light goes on is detected and counted by the counter module.

Dragging a link from the Counting tab to the light shows a popover which allows you to choose the events you want to
count, in this case "when the light goes on":

The resulting instruction for this module reads:

These examples may be found in the Tutorials section of the Home screen.
Back to Insight Modules
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Calculation module

This module performs an arithmetic calculation on two values or numbers.
The module can be programmed to begin and end the calculation:
● straight away (beginning only)
● after a specified time interval
● due to an input signal from a sensor
● according to the status of an output device
● when a value such as a temperature fulfils a certain condition
Example
The example shows how the Calculation module can be used to perform simple arithmetic with two signals. In this
case the counter modules count the number of interruptions at the two light gates and the calculation module calculates the difference between the two counter readings.

The resulting program script for these modules reads:

The Calculation tab popover allows you to define the calculation which can be a sum, difference, product or division of
two 'values' or numbers. Before using the Calculation module, 'values' have to be created using other modules such
as a Timer, Counter, Memory or another Calculation module; in each case, the value is shown in the viewer. A
summary of all the available values and viewers is available on the 'View' menu.

● Click on the first value box to show a list of available values. Instead, if you wish, you can type a number into the value box.
● Click on the arithmetic button to choose the type of calculation.
● Click on the second value box to select the second value, or type a number in the box.
The result of the calculation becomes stored as a value which is displayed in the viewer box linked to the Calculation
module. The tickboxes allow you to choose whether the viewer is displayed or hidden in Run mode. Like other values, the
result can be used in a WHEN or UNTIL setting in any other module; just drag a link from the module tabs to the viewer.
The example may be found in the Tutorials section of the Home screen.
Back to Insight Modules
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Memory module

This module records a single event so that the information can be used later.
The module can be programmed to begin and end the recording:
●
●
●
●
●

straight away (beginning only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example
This example shows how the Memory module can be used to remember an event. In this case, the motor can only be
turned on by the microswitch if the set button has been pressed previously.

In Design mode, drag a link from the Memory tab to the 'set button'. Clicking the Memory tab shows a popover which
allows you to choose the event to be remembered.

The Memory tab panel allows you to specify the type of event which you
want to be remembered. An event is detected when a signal from an
input or output changes (in this case 'gets pressed').

In this example, the resulting program script for this module reads:

The program stores the memorised event as a memory ‘value’ which is given a unique name, displayed on the viewer
connected to the module. The memory value is initially ‘null’ when the instruction commences. It becomes set to ‘0’
when the WHEN condition is fulfilled, and is then set to ‘1’ when the event has been detected. The tick boxes allow
you to choose whether the viewer is displayed or hidden in Run mode. If you wish, you can store the value in a previously defined memory value; simply drag a link from the memory tab to another viewer.
Any module (including the current one) can use this memory value for a WHEN or UNTIL condition; just drag a link
from the module tab to the memory viewer.
This example may be found in the Tutorials section of the Home screen.
Back to Insight Modules
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Message module

The purpose of this module is to display a message on the screen when a specified signal condition occurs. The
message is displayed straight away or in response to a signal and it shows for a period of time or until a signal
changes.
The module can be programmed to begin and end the message display:
●
●
●
●
●

straight away (beginning only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example
This example shows how a message can be displayed when an output device is switched on. In this case the
message only shows when the red light is on.

Tapping the MESSAGE tab shows a popover for typing the message you want to appear on the screen.

The program will display the message in a viewer which is always linked to the module in the Scene window or
System window. (If no viewer appears to be available, click 'Reset viewer' to create a new one.) The Visible and Hide
settings allow you to choose whether the viewer is displayed or hidden in Run mode when not in use.
The resulting instruction for this module reads: "When the red light is on, show message "It is safe to cross the
road.", until the red light is off."
This example may be found in the Tutorials section of the Home screen.
It is possible for more than one message module to send a message to the same message viewer; simply drag a link
from the MESSAGE tab to the chosen message viewer.
Back to Insight Modules
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Sound module

This module plays a sound through the iPad's sound system. The sound plays straight away or in response to a
signal and it repeats for a period of time or until a signal changes.
The module can be programmed to begin and end the sound:
●
●
●
●
●

straight away (beginning only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example
This example shows how a sound can be played when an output device is switched on. In this case, the thunder
sound plays when the light flashes.

Tapping the SOUND tab shows a list of sounds in the iCONTROL library.
Touching any sound name in the list will play the sound to you.
Tapping a name will select it.

To show that a sound is ready to play, the program will display a sound viewer which is always linked to the module in
the Scene window or System window. (If no viewer appears to be available, click 'Reset viewer' to create a new one.)
The Visible and Hide settings allow you to choose whether the viewer is displayed or hidden in Run mode when not in
use. The sound clip keeps repeating until the UNTIL setting is fulfilled.
The resulting instruction for this module reads: "When the lightning goes on, play sound "Thunder" for 2
seconds."
This example may be found in the Tutorials section of the Home screen.

Back to Insight Modules
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Logger module

This module allows you to is to record a signal and display it as a graph against time.
The module can be programmed to begin and end the recording:
●
●
●
●
●

straight away (beginning only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example
This example shows how the logger module plots a graph of the signal from an input sensor. Choose the sensor by
dragging a link from the Logging tab to the sensor.

Clicking the Logging tab shows a popover which allows you to
choose the axes limits:

The program displays a graph of the recorded data in a viewer
which is always linked to the module in the Scene view or
System view. (If no viewer appears to be available, click
'Reset viewer' to create a new one.) The Visible and Hide
settings allow you to choose whether the viewer is displayed or
hidden in Run mode when not in use.

In this example, the resulting program script for this module reads:

This example may be found in the Tutorials section of the Home screen.

Back to Insight Modules
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Pause command

This module is used in a sequence of instructions. The pause may begin straight away or in response to a signal and
it lasts for a period of time until a signal changes.
The pause may begin or end:

●
●
●
●
●

straight away (begin only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

Example
A simple application of the Pause command is to make a light flash on and off repeatedly. Starting with a Simple
module switching on the light for 0.5 seconds, this can be implemented in two ways:
The first is to DOUBLE click on the module and select 'Add instruction'. Choose 'Pause' for the second instruction.

Then drag a link from UNTIL to TIME and adjust the length of time for the pause.

In this example, two instructions appear in the text panel:
"Switch on the light for 0.5 seconds.
Wait for 2 seconds."
This example may be found in the Tutorials section of the Home screen.

Back to Insight Modules
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Repeat command

This command is useful when you want to repeat one or more instructions a specified number of times or until a
certain condition is fulfilled. A module containing this command must have at least one other instruction following so
that there is a sequence. It is normal to make the Repeat command the first in a sequence of instructions.
The Repeat may begin straight away or in response to a signal and it lasts for a period of time or until a signal
The Repeat may begin or end:

●
●
●
●
●

straight away (begin only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

The Repeat command normally repeats all the instructions which follow it, but if you insert a second or third Repeat
command in a sequence, the program will complete repeating the first set of instructions before proceeding to the next
Repeat.

Example 1
This example shows the use of the repeat command to repeat a sequence of instructions a limited number of times.
When the button is pressed, a double ring of the bell is repeated 4 times.

The Repeat is programmed by touching the TIME tab and selecting the number of repeats required.
The instruction following the repeat causes the bell to ring twice in quick succession. The program script for the
module becomes:
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Example 2
This example shows the use of two repeat commands in a sequence of instructions. The first repeat operates on the
instructions up to the second repeat. When the button is pressed there are four flashes of the yellow light followed by
two flashes of the blue light.

As with the first example, the Repeat is programmed by touching the TIME tab and selecting the number of repeats
required. The program script for the module becomes:

These examples may be found in the Tutorials section of the Home screen.
Back to Insight Modules

Values and Viewers
'Values' are variable numbers stored in the program. (They are equivalent to numeric variables, commonly found in all
types of computer program.) They provide a powerful mechanism by which signals can be sent from one module to
another. Modules can communicate with each other by sending or receiving a 'value'. The modules which generate
values are Timer, Counter, Memory and Calculation. Each such module or instruction generates a value which is assigned a unique name by which it is identified.
For every value there is a 'viewer' which can display the value in the System or Scene view. The viewer takes the
same name as the value name and you can choose how the viewer displays the value in Run mode by the tickbox
settings in the module properties box. Sometimes it is not necessary to display the value at all, in which case you do
not tick the 'visible' tickbox. Sometimes you only want the viewer to appear when the module or instruction is active
and a value is being generated; in this case you would tick the tickbox for 'Hide when not in use.'
The WHEN and UNTIL conditions for all modules may use a value instead of a sensor signal; simply drag a link from
the WHEN of UNTIL tab to the required viewer and choose the condition in the popover.
A summary of the values currently defined is shown in the Values window (View menu). In Run mode this window
serves as a monitor of the values.
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Call command

This executes the instructions of another module in a manner similar to calling a subroutine in conventional computer
programs.
The command may be executed:
●
●
●
●
●

straight away (begin only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

The Module tab allows you to specify which module will be executed when the start condition is fulfilled: drag a link to
the required module.
N.B. When a module is called, the instructions in the module are only executed once, then control returns to the
module containing the 'Call' command. Thus the normal loop rule does not apply to the module being called; its
execution is inhibited until the Call command occurs.
The Call command is useful when you want:
● a module to be executed by more than two independent sensors.
● several modules to be executed one after another in a sequence

Example
This example illustrates both of the above uses. It shows extracts from the control systems for a fairground scene in
which there are several modules controlling lights and motors for a variety of exhibits and rides. Notice that nearly all
the control modules have an instruction which switches on the device(s) straight away. In fact the instruction is only
executed when the module is 'called' by the Call command.

The call is programmed by dragging a link from the MODULE tab to the module you wish to call.
The 'funfair tour' module contains a sequence of five 'Call' commands. One way of creating these is to double click on the
module and add further Call instructions, each time dragging a link from the MODULE tab to the destination module.

© 2015 Insight Resources

41

An alternative method of creating the sequence is to create several call modules, and linking each to a different
destination module as before. The vertical arrangement defines the order of the sequence, from top to bottom.
Finally, the modules have to be merged: highlight all the modules (drag a rectangle around them), DOUBLE click on
one of them and select 'Merge selected modules'.

In this example, the sequence of instructions for the 'funfair tour' module appears in the text panel thus:

This example may be found in the Tutorials section of the Home screen.

Back to Insight Modules
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Reset command

This command is used for resetting a value (associated with a viewer) to its initial ‘null’ or undefined state.
The command may be executed:
●
●
●
●
●

straight away (begin only)
after a specified time interval
due to an input signal from a sensor
according to the status of an output device
when a value such as a temperature fulfils a certain condition

When a function module (Timer, Counter, Memory or Calculation) or instruction first becomes active, it sets the associated ‘value’ to a ‘null’ or undefined state. Later, when the WHEN condition is fulfilled and timing or counting actually
starts, the initial value shown in the timing or counting settings panel is stored as the ‘value’. The effect of the reset

command is to clear the number stored and return the value to its ‘null’ state.The Value tab allows you to specify the
name of the value which will be reset when the start condition is fulfilled: Drag a link to the required viewer.

Example
This shows the common use of the Reset command in returning a counter value to its initial state. It is implemented by dragging a link from the 'Value' tab to the counter viewer:

In this example, the text panel shows this instruction:
"When the reset button gets pressed, reset 'counter'.
This example may be found in the Tutorials section of the Home screen. See also '3. Car park++' in the Examples section.

Back to Insight Modules
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Designing your own control systems and scenarios

To create a new control system from scratch in the System view:

Click on 'New' in the Home screen.
Select the sensors, module and devices that you need, then link and program them following the
rules previously described.

Creating your own scenario

If you want to create a new scenario in the Scene view, you should load the DIY Toolkit which is available in
the Projects tab in the Home screen. This gives you a range of switches, sensors and devices which can be used in a
variety of everyday scenarios. Control systems can be built in the usual way by selecting the modules you need. If you
wish to work on programming in the System view, this is sometimes more convenient; then you can switch back to the
Scene view when you want to adjust the layout of the items in the scene.

Choosing a background image
Select 'Edit' menu and choose the
option. A selection of built-in background images shows when
you click the 'Standard' box. Alternatively, you can locate and import your own images or photos using the 'Browse'
button.

Designing your own sensors and devices (Construction menu)

Programming
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Construction menu
The 'Construction' menu is normally hidden, but, when in Design mode, it can be made visible by going to the
Preferences page and ticking the box for Construction.
Items on the 'Construction' menu allow you to create and edit the text, pictures and animations associated with
sensors and devices. They only become active in Design mode.
Edit Pictures...
Highlight a sensor or device first, then select 'Edit pictures...'

The High panel shows the series of frames, each containing an image, which appear as a sequence to create
animation when the sensor or device is in a high (on) state.
Add...
Add another image at the end of the sequence. An Open dialogue allows you to select the image.
Insert...
Insert an image before the highlighted image.
Set...
Replace the highlighted image
Remove... Remove the highlighted image.
Save...
Save the highlighted image.
Start
Defines which frame shows first when animation begins.
The Design/Low panel shows the image that appears in Design mode and when the sensor or device is in a low
Set...
Replace the image
Remove... Remove the image.
Save...
Save the image.
Design mode only When ticked, the animation ignores the Design/Low image.
Animation panel:
Duration setting
This defines the time between frames.
Sequence settings
These define the order of playback of the frames when the sensor or device goes to the high (on) state:
Simple Play the frames from first to last and stop.
Oscillate Play the frames from first to last and back again, repeated until the low (off) state occurs.
Loop
Play the frames from first to last repeatedly until the low (off) state occurs.
Transition settings
These define the playback of the frames when the sensor or device goes to the low (off) state:
No change Stop with the latest frame.
Jump
Jump to the Design/Low image.
Animate
Play the remaining frames back to the first as defined by the Sequence settings.
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Edit Text...
Highlight a sensor or device first, then select
'Edit text...'

The dialogue allows you to define for a
particular sensor or device the phrases that are
used for the WHEN and UNTIL settings. %u is
a string variable for the name of the sensor or
device. %v is a numeric variable for the
'threshold value'.

Copy To Gallery
In the Scene view, the highlighted object will be copied into the Gallery window for sensors or devices.

Delete From Gallery
In the Scene view, images in the gallery windows for sensors and devices may be highlighted and moved by holding
down the CTRL key whilst clicking or dragging the image. Clicking on Delete From Gallery will remove highlighted
images from the gallery window.

Create Object...
This option allows you to import an image for placement in the Scene view. It will have no functionality except to add
visual material to the view. It may be used to add a photo or clip art in aff, emf, wmf, jpg, or bmp formats.
If you want to create an image with sensor or device functionality, select the System view, select the item you want,
then return to the Scene view and use Edit Picture... to import the image you want.

Set Thumbnail...
When you save a file, a thumbnail
image will be automatically
created from the current screen
view. Use this option if you want
to choose a different image.

Set from window This makes a thumbnail image from the current screen.
Set from file...

This allows you to select an image which you have previously saved as a file in jpg, bmp or wmf formats.

Width and Height These inputs determine the size of the thumbnail in pixels.
Save...

This allows you to save the thumbnail image as a separate file in jpg format.

Default

This sets the thumbnail image from the view in the Scene view in Run mode.

Edit menu
© 2015 Insight Resources

46

Moving images and animation
In the Scene view, pictures of items which are motorised, or connected to a motor, can be made to move across the
screen in Run mode when the motor switches on forwards or backwards. This simulates the effect in real models of
the items being pulled along or up and down by pieces of string attaching them to a motor spindle or pulley. You can
define the movement as follows:
●
●
●
●
●
●
●

Set the program to Design mode.
Highlight the object you want to move.
Go to the 'Edit' menu and select 'Movement'.
Drag the object to the position you want it to move to.
Click on the Set forward position button in the Movement box.
Select the 'Sequence', 'Transition' and 'Duration' settings according to the type of motion required (see below).
Click OK.

If required, the Set backward position button can be used to define an additional position for the movement when
the motor runs backwards.
Sequence settings
These define the direction of movement:
When the motor switches ON:
Simple Move one way from Start to Forward positions.
Oscillate Move both ways between Forward and Start positions.
Loop
Repeat movement from Start to Finish positions.
When the motor switches OFF (except when Transition setting is 'No change'):
Simple Move one way from Forward to Start positions.
Oscillate Move to Start position.
Loop
Move to Start position
Transition settings
These define how the object appears to move from one position to the next:
When the motor switches ON:
No change As defined by Sequence setting.
Jump
As defined by Sequence setting.
Animate
As defined by Sequence setting.
When the motor switches OFF:
No change Stay at current position.
Jump
Jump to Start position.
Animate
Move gradually to Start position.
Duration setting
This defines the time taken to travel from the Start to Forward positions when the motor speed is set to 100%.
At 50% speed, the actual time taken would be twice the duration time etc.
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The Edit menu

Undo / Redo
Any action you perform whilst editing in Design mode can be undone or re-done by selecting these options on the
'Edit' menu or clicking the buttons on the main toolbar.

Duplicate
To help you build larger systems, you can duplicate systems or parts of systems. Simply highlight in Design mode
the items you want to duplicate and select the 'Duplicate' option on the 'Edit' menu.

Delete
This deletes an object or picture when highlighted in Design mode.

Bring to front
When a picture is highlighted in the Scene view in Design mode, this option brings the picture to the foreground.

Send to back
When a picture is highlighted in the Scene view in Design mode, this option makes the picture appear behind other

Properties...
A sensor or device needs to be highlighted before using this option, which shows the properties box for the highlighted item. This allows you to edit the name of the sensor or device.
● For a digital sensor you can also specify the initial state of the sensor when you begin Run mode.
● For an analogue sensor you can specify the initial value given by the sensor when you begin Run mode and
the threshold at which the sensor signal is treated as ‘high/on’.
● The tickbox allows you to make the picture of the item in the Scene view also show in the System view.
● For an analogue sensor you can specify the number of decimal places used when its signal is displayed.
Sound...
This allows you to give any sensor or device a sound when the item is activated. A separate sound may be allocated
to each signal level or transition associated with the item.
Movement...
This allows you to define the movement of motorised objects in the Scene view. More details.
Background...
This allows you to choose the graphics file for the background picture in the Scene view. Click on the Set button to
show the Open dialogue box. Select the picture file required and click OK. Files with ‘.jpg’, ‘.emf’, ‘.aff’ or ‘.bmp’ formats may be loaded. You can use your own picture from a digital camera if it is in the ‘.jpg’ or one of these formats.
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Preferences...
● Caption Font Allows you to change the font size and style for the text which appears in caption boxes and
system boxes in the System view.
● Scene

Allows you to choose the colour of the link lines in the Scene view. Devices

decimals allows you to choose the number of decimal places for the displays of time values.
debounce allows you to specify a debounce delay for detecting the ‘goes high/on’ or ‘goes low/off’
transition. This is useful for detecting signals from simple switches which might give multiple transitions (‘switch bounce’) when contact is made or broken. A delay not exceeding 0.1 second is recommended. It has the effect of ‘debouncing’ a switch, which is sometimes important when trying to
count pulses or changes in signals.
● Construction This enables the 'Construction' menu to appear on the main menu. The Construction menu
allows you to define the images and animation characteristics for sensors and devices which are required to
appear in the Gallery window. It also allows you to choose a thumbnail image for the file when it is saved.
● Components... You can choose which components are displayed on the on the drop-downs for sensors,
modules and devices in Design mode. The 'Intermediate' and 'Junior' buttons offer pre-selections at two
simpler levels of complexity.
● Instruction Font Allows you to change the font size and style for the text which appears at the top panel of
the main windows the Script window and on objects in the System view.
● Signal language You change choose between three different styles of describing signal conditions in the
module properties box: high/low, on/off, context (dependent on the type of sensor selected).
● Toolbar size You can choose the size of the toolbar and its buttons.
● System tooltips When ticked, tooltips show the script for the module when you point to the module.

Programming
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Teaching Support
Learning Aims and Objectives
The aim of Insight iCONTROL is to enable pupils:
To break down a problem into simple stages and express each stage as a computer instruction.
The unique feature of Insight iCONTROL is to offer a programming environment which expresses decisions and
actions in plain English. It encourages pupils to analyse a problem into simple steps which are represented by
grammatical statements rather than by symbolic code. As such, it helps to develop 'computational' thinking, the
essence of which is to produce structured solutions as a pre-cursor to writing computer code.
The specific learning objectives of activities with Insight iCONTROL have four levels of sophistication:
Level 1: Run a control system and associate its behaviour with a program script.
Level 2: Adapt a simple control system to alter its behaviour.
Level 3: Build and program a control system to fulfil a given specification.
Level 4: To specify, design and build a control system.

Insight iCONTROL and the National Curriculum
Insight iCONTROL can be used to fulfil the following aspects of the Programmes of Study for Computing in the
National Curriculum for England and Wales (2014):
Key Stage 1
● understand what algorithms are; how they are implemented as programs on digital devices; and that
programs execute by following precise and unambiguous instructions
● create and debug simple programs
● use logical reasoning to predict the behaviour of simple programs
● recognise common uses of information technology beyond school
Key Stage 2
● design, write and debug programs that accomplish specific goals, including controlling or simulating physical
systems; solve problems by decomposing them into smaller parts
● use sequence, selection, and repetition in programs; work with variables and various forms of input and
output
● use logical reasoning to explain how some simple algorithms work and to detect and correct errors in
algorithms and programs
Key stage 3
● design, use and evaluate computational abstractions that model the state and behaviour of real-world
problems and physical systems
● use two or more programming languages, at least one of which is textual, to solve a variety of computational
problems; design and develop modular programs that use procedures or functions
● understand simple Boolean logic [for example, AND, OR and NOT] and some of its uses in circuits and
programming
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Begin with the Tutorial exercises.
●
●
●
●
●
●
●

Introduction
Basic control
Timing control
Sequence control
Repeat control
Parallel control
Analogue sensors

Each exercise contains an example control system and a useful follow-up activity is to build and program a copy of
the system. This may then be followed by tackling Fix-it exercises recommended at the conclusion of the tutorial
(see below).
Every screen provides access to a Quick-help popover, summarising the procedures for building, programming
and running control systems.

Start with Fix-it activities.
These are single-focus activities, ideal for class use when pupils are learning how to use Insight iCONTROL. Each
example offers a ready-built control system which works, but is defective in some way. The task is to alter it to make it
work better. Pupils learn both from seeing how the system works, and from adapting the control program to produce
different effects.
More about Fix-its

Work with Project activities.
Each project scenario contains pre-selected sensors and devices ready for building simple control systems. There
are on-screen instructions in Design mode which specify the tasks which the control systems are intended to
perform. The challenge to pupils involves programming the systems.
For each project scenario there is a second '+' version containing a ready-built control system demonstrating a
solution to the project activity tasks. For further activity, more on-screen instructions specify extension tasks.
As pupils progress they can explore the Example activities containing a '++' version for each scenario. These
demonstrate a complete solutions to all the tasks.
More about Projects

Design and build new systems.
Pupils with confident skill may be challenged to specify their own control problems and then design, build and program
control systems as solutions. The All components gallery may be used as a library of sensors and devices. New
background pictures may be created by importing digital photographs from the iPad camera or from other sources.
Classroom support materials
The Help notes, Worksheets for the activities and other support materials are available as pdf files downloadable
from www.insight-icon.com
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Fix-its
Each Fix-it activity involves a single control system. The on-screen instructions indicate how the performance of the system
needs to be changed. The range of available Fix-its set in a variety of contexts are graded into three levels of skill:
♦

Beginner

♦♦ Progressing

♦♦♦ Experienced

Fix-it

Action

Skill level

bedside light
clown
computer
exit door
garage
lighthouse
microwave
robot
room light
safety alarm
TV
TV message
washer
big wheel
blender
burglar alarm
checkout
engine
fan
flashing lights
heater
mixer
moisture
roundabout
screen
spider
temperature

switching on a light for a certain time
an output controlling sound
input switch controlling a device
using a delayed start condition
changing the number of outputs being controlled
controlling the time for a light flash
controlling the time for switching on a microwave
input switch controlling a repeated light flash
input switch controlling a light
changing the number of outputs being controlled
an output controlling another device
writing a message display
repeating instructions several times
controlling the speed of a motor
using the Repeat command to flash a light
editing a pause instruction in a sequence
adjusting the speed of a motor
adding a sound
temperature sensor level controlling a fan
simple sequence of timed instructions
temperature sensor level controlling a heater
using a count-down timer
moisture sensor controlling a water pump
controlling the speed of a motor
editing a screen message
input switch controlling a motor
temperature sensor level controlling a heater

♦
♦
♦
♦
♦
♦
♦
♦
♦
♦
♦
♦
♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦
♦♦

thunder
toaster
wait sign
windmill
card
drinks
indicator
lightning
mouse
radiator
toy display
traffic lights

an output controlling sound
controlling the time for switching on a toaster
using an output signal to control a light
controlling the speed and direction of a motor
adding a screen message
creating a sequence of instructions
using 'pause' to flash a light
input switch controlling a sequence of timed instructions
controlling a motor
using two signals to control a device
changing a sequence of instructions
adding a pulse control to flash lights

♦♦
♦♦
♦♦
♦♦
♦♦♦
♦♦♦
♦♦♦
♦♦♦
♦♦♦
♦♦♦
♦♦♦
♦♦♦

train
washing machine
window

creating a sequence of instructions
adding an instruction to create simple sequence
using analogue sensors in a ventilation system

♦♦♦
♦♦♦
♦♦♦

Solutions for Fix-its: With each Fix-it activity, a suggested solution is hidden behind the task script box in the System view;
in Design mode this box may be moved to reveal the solution.
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Insight iCONTROL Projects
Having acquired some basic skills with Insight iCONTROL, pupils can learn much more by trying the project
activities. The projects are built around sixteen themes chosen to stimulate pupils' interests and to encourage
thinking about the applications of computer technology in everyday life. Each activity is provided with a store of
sensors and devices for the Scene view, partially-built control systems with instructions for development, and
complete ready-built systems illustrating complete solutions to the tasks.
Within the Project tab of the Home screen, each project scenario is presented in two different versions. For
example:
● Bedroom contains prepared sensors and devices but requires modules to be defined and programmed.
● Bedroom+ contains completed control systems for Bedroom, plus instructions for building further systems.
The Examples tab of the Home screen contains a further version of each scenario, containing complete systems,
effectively providing a model answer for the Bedroom+ project and similar projects.
A summary of the project scenarios is shown below with lists of the types of activities in each. The general order
of progression is indicated by the diamond symbols.
♦ Beginner
♦♦ Progressing
♦♦♦ Experienced

Project worksheets
Each project activity includes brief on-screen instructions for the graded tasks. However, the project worksheets
present more detailed guidance for thesetasks. Some of the worksheets begin with a short story which teachers
may find useful for setting a context for the activities. All the worksheets contain step-by-step instructions for
building and programming a control system for the basic activity and then give instructions for altering systems and
adding further systems in the extended activity.
♦ Dream Bedroom

♦ Inventor's Workshop

Moving and sizing an object
Using 'goes on' and 'is on' settings
Altering duration times
Connecting different inputs
Using a temperature sensor
Comparing analogue signals

Flashing a light with a two sentence sequence
Changing a text message
Altering duration times
Altering the speed and direction of motors
Selecting different combinations of output devices
♦ Toyshop Magic

♦ Kitchen Gadgets

Making devices work for set times
Changing speed and direction of motors
Building sequences of changes and pauses
Creating an alternate ON/OFF sequence
Using a temperature sensor
Adding a sound module

Flashing lights with a two sentence sequence
Altering the speed and direction of motors
Switching different outputs and combinations
Making and altering a sequence
Editing a text message
Adding a sound module
♦♦ Car Dashboard

♦ Motorbike

Connecting inputs to control outputs
Flashing lights with a two sentence sequence
Adding a sound module

Using a 'goes on' event to control an output
Flashing lights with a two sentence sequence
Combining two signals with AND and OR logic
Alternating instructions in a two sentence sequence
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♦♦ Central Heating

♦♦ Drinks Machine

Using a temperature sensor
Comparing analogue signals
Alternating messages in a three sentence sequence
Combining two signals with AND and OR logic

Building a sequence of instructions
Using the 'pause' instruction
Using a sequence to require three input events
♦♦ House security

♦♦ Food mixer

Switching motors on and off
Using a Timer as a count down delay
Combining two signals with AND and OR logic
Controlling the direction of a motor
Building a sequence of instructions including pauses

Using sensors to control sequences
Simple timing; altering delay times and duration times
Combining two signals with AND logic
♦♦♦ Car park

♦♦ Supermarket

Adjusting the speed and direction of electric motors
Pulse settings and ‘Pause’ command
Altering delay times and duration times
Using a light gate
Combining two signals with AND/OR logic
♦♦♦ Cash dispenser

Displaying and editing messages
Building a sequence of instructions including pauses
Adjusting WHEN and UNTIL settings
Combining two signals with OR logic
Using a signal from an output device to control a module
♦♦♦ Greenhouse

Using analogue signals in environmental control
Adjusting signal thresholds and comparing analogue signals
Using outputs as signals for controlling modules
Adding a pulse control and adjusting pulse settings
Combining two signals with AND logic
♦♦♦ Pelican crossing

Creating more complex sequences
Altering delay times and duration times
Using output signals to control modules
Adding a pulse control and adjusting pulse settings
Combining two signals with AND logic

Building a sequence of instructions with time delays
Counting events and performing calculations
Combining two signals with OR logic
Using a signal from an output device to control a module
♦♦♦ The Fun of the Fair

Moving and sizing objects
Creating a sequence of flashing lights
Altering the speed and direction of motors
Combining signals from two sensors with AND logic
Using a sound module
♦♦♦ Haunted House

Flashing a light with a two sentence sequence
Altering the speed and direction of a motor
Combining two signals with OR logic
Using outputs as signals for controlling modules
Adding a sound module
Contents
♦♦♦ Petrol station

Creating more complex sequences
Counting events and performing calculations
Combining two signals with AND and OR logic
Using output signals to control modules
Back to Teaching Support
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